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Preface 
 

 

Targeted Readers Software engineers, who wish to become familliar with the design environment of V850 

microcontrollers to develop and evaluate applications on the TK-850/JH3E+UD evaluation 

boards. Readers are expected to possess the basic knowledge of microcontrollers, C 

language, and Windows™ OS.  

 

Objective Readers will learn how to play around the TK-850/JH3E+UD evaluation board with the V850 

design environment.  

 

Construction This manual consists of the following chapters 
 
Chapter 1 Installation 
→ Installation of the sample program and preparation of the TK-850/JH3E+UD boards. 
 
Chapter 2 Experiences 
→ Experience how to operate the project manager PM+, compiler, and the integrated 

debugger while preparing the implementation of the sample program. 
 
Chapter 3 Hardware Specifications 
→Explain the hardware of TK-850/JH3E+UD 
 
Chapter 4 Troubleshooting
→Describe how to solve troubles you may face, such as errors when starting the integrated 

debugger (ID850QB) 
 
Chapter 5 Other Information
→Introduce other information, such as how to create a new workspace (project) on integrated 

development environment (PM+), how to register additional source file, and some useful tips 
of the integrated debugger. 
The circuit diagrams of demonstration kit are included in this chapter. 

 
Chapter 6 Sample Prgram 
→How to use the sample program "RF Test Program" and “Ethernet gateway program” 
 
Chapter 7 Mode Setting of the Board
→ Explanation of switch setting. 
 

 
NOTES         The information in this document is subject to change without notice. No part of this document 

may be copied or reproduced in any form or by any means without the prior written consent of  
Renesas Electronics Corporation. Renesas Electronics Corporation. assumes no liability for 
infringement of patents or copyrights of third parties by or arising from use of a product 
described herein. 
Renesas Electronics Corporation. established proven quality assurance procedures for all 
products manufactured by or on behalf of Renesas Electronics Corporation. As part of product 
qualification process an intensive release test procedure has been established and executed 
before the products are released for mass production and delivered to our clients. Renesas 
Electronics Corporation. would like to inform, that the standard quality assurance procedure(s) 
have not been fully applied to this product and its documentation and that neither of TESSERA 
TECHNOLOGY INC. or Renesas Electronics Corporation. can assure the full and error free 
function and/or the standard quality level. 

 
CAUTION          This equipment should be handled like a CMOS semiconductor device. The user must take all 

precautions to avoid build-up of static electricity while working with this equipment. All test and 
measurement tool including the workbench must be grounded. The user/operator must be 
grounded using the wrist strap. The connectors and/or device pins should not be touched with 
bare hands. 
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Trademarks        ZigBee is a trademark of Koninklijke Philips Electronics N.V. Windows is a trademark or 

registered trademark of Microsoft in the United States and other countries. Renesas 
Electronics , V850ES and 78K0 are trademarks of Renesas Electronics Corporation in the 
United States and/or other countries. All other registered trademarks or trademarks are 
property of their respective owners. 
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Chapter1  Installation 
 

 

 

This chapter introduces the development tools and explains the installation of the sample program.  

The sample program can be tested on this hardware platform of the evaluation kit. 
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1.1 Development Tools 
 
 
 
 

The following development tools are utilized in the TK-850/JH3E+UD board. 

 

● Integrated development environment PM + V6.32 
PM+ stands for Project Manager. It is an integrated development environment platform, working on MS 

Windows. Editor, compiler, and debugger are managed on PM +. 

 

● Device File DF3786 V1.00 
The Device File loads the CPU hardware information into the development tools.  

The sample program in this tutorial was compiled for V850ES/JH3-E, based on the information in the device 

file. 

 

● C compiler CA850 W3.40 (Code size limited version) 
C compiler for the V850 microcontrollers. The object code size is limited to 128 Kbyte.  

This compiles C code for V850 and ANSI-C code program into assembler code. 

This produces object code and linker. 

 

● Integrated debugger ID850QB V3.60 
Debugging tasks are performed by the debugger ID850QB with the monitor program stored in the Embedded 

Flash EEPROM in the microcontroller via USB-UART interface. Once the debugger is initiated, object user 

code is automatically downloaded onto the on-chip Flash EEPROM. 

 

● Flash EEPROM programmer WriteEZ5 
The programmer is a piece of software, operating on MS Windows. It programs, erases, and verifies object code 

in the embedded Flash EEPROM in the microcontroller, via USB cable from PC. 

 

● Starter kit USB driver  

This is a software driver for PC to access to the USB interface of the TK-850/JH3E+UD board.  

 

● The RF Test Program 
The RF Test Program is explained in [chapter 6 Experiences]. 

 

The RF Test Program is provided in the form of the C source codes.  

If you wish to tailor the RF Test Program to meet your specific needs, you can edit the source code, 

re-compile it with debug build to generate a load module file, then, start the debugger to load the tailored 

execution code on to the microcontroller for further debugging on the project manager PM +. 

Alternatively, if debugging is not required, you can make a release build to achieve a new hex file, on the 

project manager PM +. 

As a general remark, please respect your local regulation of electro-magnetic emission. In general, it is 

suggested to use the board in a radio anechoic chamber. 

 

● Ethernet gateway sample program 

The Ethernet gateway sample program supplies network information of the 78K0R UD Stick in the wireless 

network via Ethernet.
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1.2 Installation of Software Development Tools 
 
 
 

1.2.1.  Explanation of this CD-ROM 
 

The attached CD-ROM contains Development Tools, documents and sample software.  
You can install it using an installer. 
 

 
1.2.2. Installation of the software development tools 

Insert the CD-ROM in the CD-ROM drive. The installer is started automatically. 
If it does not start automatically, start SETUP.EXE from Explorer, etc. 
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<1> Selecting Install… from “NEC Electronics Microcomputer Development Tools Setup” open
s the following dialog box.   
Select the device file and the tool to be installed using the check box.  
By selecting Search…, a device file product can be selected by device name 
“Explain” displays an explanation of the selected device file or tool. 
To change the installation destination, select Browse…. 
  
When all the settings are complete, select Install…. 
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<2> To install each development tool, click OK when the install confirmation screen is displayed.  To 
stop installation, click Cancel.  

 

 
 

<3> To install each development tool, click Yes when the software license agreement screen is 
displayed.  To stop installation, click No. 
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<4> Enter the product ID. The product ID is shown on the attached documents [README.HTML]. 
 

 
 

 

 
<5> Copying the files is started. 
 

<6> If the setup have completed, a dialog box indicating completion of setup is displayed.  Click the 

[OK] button.  This completes installation of each development tool. 
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 Notes on the installation  
・ Support OS: Windows XP and Windows 2000 (only English version) 
・ Administrator authority is required for this installation.  
・ Do not use 2-byte and /*:<>?|"¥;, characters for installation directory name and also do not select 

installation directory path that contains those characters.  
 
 Limitation  
・ C compiler CA850 W3.40 limit the object size to 128 Kbyte. 

 
 

About ID850 
 
ID850QB can set following break points. 
  Hardware Break  2 points 
  Software Break  4 points (Internal flash memory) 
 
 
 
 
 

1.2.3. Structure of Installed Files 
 

 

Software Development Tools are installed in "C:/Program Files/NEC Electronics Tools" on default 

setting. 

When you use the tools, please open the tools from [Start menu] -> [Programs]->[NEC Electronics 

Tools]. 
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1.3 Sample Environment 
 

 

 

 
 
This section describes the preparations for the sample programs used in this document. The 
preparations consist of installing the sample programs in the customer’s environment. 
 
The installation method and the installation destination are cescribed below. 
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1.3.1. Installing the sample program 
 
 

Insert the TK-850/JH3E+UD CD-ROM in your PC. The [NEC Electronics Microprocessor 
Development Tools Setup] screen will automatically show up. (if this screen does not show up 
automatically, please start setup.exe from Explorer.) 
Press the  Sample Program  button to start the Internet Explorer, and then click the [Sample 
Program] link.  

 

   

Internet Explorer 
will show up 

 

 

Click the [TK-850/JH3E+UD Sample 

Program] link.  

The lower line is the link to download 

this tutorial. 

 
①  Click the “TK-850/JH3E+UD Sample Programs” link , the following download confimation 

window appears. 
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②  Click the  Save  butten. 
 
 

 
 
 
③  After specifying the download destination folder，click the  Save  button.  
 
 
 
④  The self-extraction sample program (TK850.exe) is copied to the specified folder.  

The folder that the “TK850” folder is made when this file is executed, and the sample program is 
stored under the”TK850” folder. 
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1.3.2. File Configuration of the sample program 
 
The sample programs ware the following folders. 
 

 

 

 

 TK850 
 JH3+UD 

SAMPLE_JH3EUD 

SAMPLE_JH3EUD.prw The sample program used in chapter 2. 

 

V850ES_RF_Test 

V850_RF_Test.prw The packet error rate and received 

signal strength indication are monitored.

Refer to the chapter 6 for details. 

 

Ether_Gateway Ethernet gateway sample program 

 

 

 

 

 

 

 

 

 

 

 

TK-850JH3E+UD_ZC.hex TK-850/JH3E+UD programming file   

 78K0R_UD_Stick_ZED.hex 78K0R UD Stick programming file 

(end device)  

 
78K0R_UD_Stick_ZR.hex 78K0R UD Stick programming file 

(rooter ) 
 

 
Refer to the "TK-850/JH3E+UD 

sample program reference manual" 

for details 
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1.4 USB Driver 
 

 

 
"NEC Electronics Starter Kit Virtual UART" USB driver must be installed on PC before you start using the 

TK-850/JH3E+UD. 

Please, follow the instruction below to install the driver. 

"Starter Kit USB Driver" must be installed on the PC. If not, please refer to "1.2Installation of Software Development 

Tools" to install the driver first.  

 

CAUTION:  

Do not use a USB hub for connecting TK-850 

 

First, connect the TK-850 to PC with USB.  

 

Depending on the version of Windows OS, the installation will be differed. Please check your Windows version, 

and follow the instructions 

   - Windows XP   -> "1.4.1 Installation on Windows XP" 

   - Windows 2000 -> "1.4.2 Installation on Windows 2000" 

After the installation, go to "1.4.3 Completion of USB Driver Installation" 

 
 8

1.4.1. Installation on Windows XP 
 
１． Once the TK-850/JH3E+UD is connected with USB, the "Found New Hardware Wizard" will be started.  

Select "No, not this time" and click  Next >  .  
 

 

Select "No, not this time" 

Click "Next" 
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2. Select "Install from a list or specific location" and click  Next >  .  
 

 

Select "Install from a list or specific 

location" 

Click "Next" 

 
 

 
 
3. Select "Search for the best driver in these locations.", check "Include this location in the search:", and then 

click "Browse..." to select the driver directory path. The path should be "C:¥Program Files¥NEC Electronics 
Tools¥TK-driver" as default installation. If the installation directory is not default, then select "TK-driver" under 
the installation directory.  
Click  Next >  . 

 

 

Select the driver directory 

Click "Next" 
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4. If the following dialog is opened, click  Continue Anyway  .  
 

 

Click "Continue Anyway" 

 
 
 
 

5. The installation of "NEC Electronics Starter Kit Virtual UART" driver is completed.  
Click  Finish  . 

 

   

Click "Finish" 

 
 
 

6. Go to "1.4.3 Completion of USB Driver Installation". 
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1.4.2.  Installation on Windows 2000 
 

１． Once the TK-850/JH3E+UD is connected with USB, the "Found New Hardware Wizard" will be started.  
Select "No, not this time" and click  Next >  .  

 

Click "Next" 

 
 

2. Select "Search for a suitable driver for my device". 
Click  Next >  .  

 
 

Select "Search for a suitable driver for my 

device" 

Click "Next" 
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3. Select "Specify a location". 
Click  Next >  .  

 

 
 
 
 

4. Select the driver directory path. The path should be "C:¥Program Files¥NEC Electronics Tools¥TK-driver" as 
default installation. 
If the installation directory is not default, then select "TK-driver" under the installation directory.  
Click  OK  . 

 
 

 
 
 
 

 

Click "Next" 

Select "Specify a location" 

Click "OK" 

Select the driver directory 
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5. Click  Next >  .  
 

 

Click "Next" 

 
6. The installation of "NEC Electronics Starter Kit Virtual UART" driver is completed.  

Click  Finish  . 
 

 

Click "Finish" 

 
 
7. Go to "1.4.3 Completion of USB Driver Installation". 
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1.4.3. Completion of USB Driver Installation 
 
Confirm the USB driver is installed on PC. 
 
Start "Device Manager", and find "NEC Electronics Starter Kit Virtual UART" (without "?" mark) 
under the "Ports (COM & LPT)". 
 

 
Device Manager 

 

Find "NEC Electronics Starter 

Kit Virtual UART (COMx)" 

 
The screen above shows that the COM port number is "COM8". If ID850QB is not in use, you can 
use this port number for connecting TK-850/JH3E+UD. 
When you change the USB port connection, the COM port number will be changed as well. 

 
  

CAUTION 
・Do not do “Hardware Modification Scan” when you communicate with the target device. 
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Chapter2  Experiences 
 

 

 

 

In this chapter, you will experience how to use the development tools with using the sample 
programs. The development tools are : 
  - Integrated Development Environment, PM+ 
  - Integrated Debugger, ID850QB 

 

You will use the programs that you prepared in "1.3Sample Environment", as the sample programs 
for TK-850/JH3E+UD 
 
You will be able to understand how to use the development tools and the concept of project files 
which you need for producing application programs.  
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Overview 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Debugging

Open the workspace for a project

Check Debugger Settings

Start-up PM+ 

Check Board Settings 

Compile for an execution file 

Starting integrated debugger (ID850QB) 

Executing program

Stopping program 

Terminating integrated debugger (ID850QB)

Terminating PM +
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2.1 Starting up PM+ 

 
 
 

Now you start to experience development tools. 
To start up PM+, please select [Programs] -> [NEC Electronics Tools] -> [PM+ V6.32] in the 
Windows start menu. 

 

PM+ Strats up 
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2.2 How PM+ looks like 
 
 

 
In PM+, a project is defined. A project comprises of (an) application program(s) and environment. 
In a project, editing, building, and debugging of source codes are managed by PM+. PM+ also 
defines a work space. A work space comprises of one or more projects, and managed by PM+.   

 
 

 

 

Menu Bar 
Tool Bar 

Output Window Project Window 
 

 

 
Project Window: A window where the project names, source files, and include files are displayed 

in a tree structure 
Output Window: A window where build execution status is displayed 

 
     For details of the menu bar and the tool bar, please refer to the PM+ User’s Manual. 
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What is a project? 

A project is the unit in which PM + executes management, and refers to an application system and 

environment development based on PM +. 

PM + complies project information and saves it in a “project file”, from which it is then referenced. 

 

What is a project file? 

A project file is a file to which information such as the source file to be used in the project, the device name, 

the tool options for complying, and the editor and debugger to be used have been saved as “project 

information”. 

The file name format is “ΔΔΔΔ.prj”. 

Project files are created in folders that are set when creating new workspaces. 

 

What is a project group? 

A project group is a group comprised of a number of projects in an application system. 

The target devices of each project that can be registered to one project group must be the same. 

 

What is a workspace? 

A workspace is the unit used to manage all the projects or project group required for one application 

system. 

The file name of multiple project files is saved to a workspace file for referencing. 

The file name format is “ΔΔΔΔ.prw”. 
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2.3 Open a workspace (projects) 
 

 
 

In this section, you will use the workspace that you created in "1.3Sample Environment" 
For creating a new workspace, refer to "Chapter 5 Other Information". 
The workspace has information about the build environment for the sample programs. 
 
Select "File" on menu bar and "Open Workspace…". 
Then, select "SAMPLE_JH3EUD.prw" under the directory 
"C:¥TK850¥JH3E+UD¥SAMPLE_JH3EUD". 

 

 

 

 

Please open the directory you 
installed the sample program 

If you select the ”SAMPLE_JH3EUD.prw” file, please open it by the  OPEN  button. 

 29



Chapter 3 And More  

 

 

 

is loaded 

The workspace

“SAMPLE_JH3EUD.prw” 
 

 

 

Workspace: SAMPLE_JH3EUD.prw 

 

Project Group 

Project 

 
 

The workspace file "SAMPLE_JH3EUD.prw" contains one project called "SAMPLE_JH3EUD". You 
will use this project "SAMPLE_JH3EUD". 
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2.4 Check Debugger Settings 
 
 
 
 
The debugger settings have been set by the project file as well. However, because those settings 
are important for debugging, some settings are covered in this section. 
 
Select "Tools" on menu bar, then "Debugger Setting...". 
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Check if "ID850QB V3.60" is selected on "Debugger". 

 

 

 

 
 
 
 

If you cannot select "ID850QB V3.60", select "Project" on menu bar, "Project settings" -> 
"Tool version settings" -> "Detail settings" -> then select "ID850QB V3.60". 
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2.5 Check Board Settings 
 
 

 

Before connecting the PC and the TK-850/JH3E+UD with USB, you should check the setting of 

swiches on the board. 

Set the switches of the TK-850/JH3E+UD as follows.  

 

JP1 1-2 short (USB side) 
Bit1 OFF 
Bit2 ON 
Bit3 ON 
Bit4 ON 
Bit5 OFF 
Bit6 OFF 
Bit7 OFF 

SW1 

Bit8 OFF 
 

SW1 
 

 
 

 
 
 
 
 
 
 
 

JP1 
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2.6 Compile for an execution file 
 
 
You now create the execution file of the project. This task is called Build. 

Please select the build button  , or from the menu [Build], please select [Build]. 

 

Build is executed 

 

 
 

 
 
Build is completed. 
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What is build ? 

Build is a function that creates an execution file, etc., from a source file registered to the project. 

PM+ automatically performs compiling, linking, and other processes. 

On the second and subsequent builds, PM+ automatically detects files that have been updated  

from the previous build process, and complies and assembles only the modified files, thereby saving 

the time required for build.  

 
 

What is rebuild ? 

Build compiles and assembles only the source files that have been modified since the previous 

build, whereas rebuild compiles and assembles all of the source files.  

If you have modified compiler options or other settings, you have to execute rebuild. 
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2.7 Start Debugger 
 
 

 
 
In the PM+ window, please select the debug button  , or please select [Build] -> [Debug] in the menu. 
 

If you do not see the debug button, please select [Tools] -> [Debuggers] in the menu of the PM+, then, 

choose “ID850QB V3.60 Integrated Debugger”. 

 

 

 

 

 ID850QB is initiated, and the 

Configuration window will show up  
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"Configuration" dialog is opened. Follow the settings below and click "OK". 

・Enter "6" in "Main OSC" 

・Enter “8” in "Multiply rate" 

・Enter "FFFFFFFFFFFFFFFFFFFF" (F x 20) in "ID Code". 

・Select "UARTC0" in "Port" at "Target Device Connection" area 

then click  OK  . 

 

 

 
Click  Yes  when the confirmation dialog for downloading load module file is opened. 

  

Please click  YES   to download the load module file. 
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ID850QB starts and downloading the 

program to flash memory. 

 

 

When the download is 
completed, the source code 

will be displayed 
 

 

 

 
 
 
NOTE: 

Completion of the download does not mean running the programs. Therefore, even though you 

press switch on the board, it does not make anything happened. To run the sample program 

demonstration, see "2.9Execute the program". 
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2.8 Integrated DebuggerID850QB 
 
 

 
Integrated DebuggerID850QB displays the status information in the CPU. It also controls the 
monitor program. 

 
The default opening window of ID850QB looks like as follows, 
 

<Main Window> 

 

 

 Status Bar 

Menu Bar 

Status display area 

Tool Bar 

 

 
For more detail, please refer to the user’s manual of ID850QB Operation. 
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Run the sample program

 

2.9 Execute the program 
 
 
You now execute the program in the debugger. 

In the ID850QB window, please press the re-start button  , or please select [Run]→[Restart] in 

the menu bar. 

       

 

 
 
While the program is being executed, the status bar is red. 
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The LED2,4,6,8 will be turns on. 
The LED starts count up, when SW3 is pushed. 
LED count up is stopped, when SW3 is pushed again. 
The LED will be turned off, when SW4 is pushed. 
 
 
 

 
 

SW4 SW3 LED2.4.6.8  
 
 
 

  You could confirm the sample program is working. 

 

● The programs downloaded by ID850QB cannot use without ID850QB connection.  

For stand-alone operation, write the HEX file by WriteEZ5.  

For more information about the WriteEZ5, refer to "5.4 WriteEZ5" document. 
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2.10 Stop Programs 
 

 

Now, you are going to stop the program. 

Click the stop button     , or select "Run" on menu bar, then "Stop". 

 

 

 

 

 

 

Stop the program 

 

When the program stops, the status bar changes back to the original color. 
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2.11 Terminate PM+ 
 
 

To terminate PM+, please select [File] -> [Exit PM+]. 
 

 The exit confirmation dialog is 

displayed.  

 

 

 

If you click  Yes  , it saves the settings in the project file, and then closes the ID850QB. It is 
recommended to save the settings as it saves the window you used, window size, layout, etc. 
If you click  No  , it does not save the settings and closes the ID850QB. 
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2.12 Quit PM+ 
 

 

Select "File" on menu bar, then "Exit PM+". 

 

 
 

PM+ is closed. 

 

The experiences section ends now. 

You can find more information how to use the development tool and information about other useful features in 

"Chapter 5 Other Information". 
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Chapter3  Hardware Specifications 
 

 
 
In this chapter, the hardware of TK-850/JH3E+UD will be explained. 
 
 

Microcontroller μPD70F3783 V850ES/JH3-E 

External main system clock: 48MHz (6MHz x8) 
Clock 

Sub-clock: 32.768KHz 

USB (MINI B connecter) 

Connecter for N-Wire（KEL connecter） 

Connecter for Ethernet (RJ-45, TDK TLA-6T718) 

Interface Connecter for AC adopter (DC5V) 

SMA connecter (RF output ) 

Expansion connector （only pad） 

Connecter for MINICUBE2（only pad） 

Dimension 90mm x 60mm 

Power supply voltage 5V 
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3.1 Layout of hardware functions 1 
 SW3 P94～P98, P912 LED2,4,6,8 LED12 LED9 SW4 

 
 

 
 

 
 

3.2 Layout of hardware functions 2 
 

 
 

 
 
 

 
 

JP1 SW1 LED10 SW2

CN1 P76～P79 DCVDD1,2

GPIO0 GPIO1,2 RXD
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3.3 Layout of connecter 
 

CN4 TR1

 
 

 
 
 
 
 

USB1 SMA NWIRE1 FP1
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3.4 Hardware Functions 

  

3.4.1. SW1 
 

The bit 1-4 on SW1 are for mode settings, Bit5-8 of SW1 are connected to ”P76/ANI6”～”P79/ANI9” for 

general-purpose input port. 

 

● Set as shown in the following table if you wish to debug using bundled ID850QB through USB1 

SW1 

 Bit1 OFF 
 Bit2 ON 
 Bit3 ON 
 Bit4 ON 
 

* When you debug through USB1, it communicates with the host machine through P30 and P31 pins. 

Therefore, you cannot use these pins. 

    

● Please change to the following settings when writing the program to the flash memory with built-in CPU by using 

WriteEZ5. (The hardware of WriteEZ5 is built into TK-850/JH3E+UD.) 

 SW1 

 Bit1 OFF 
 Bit2 ON 
 Bit3 ON 
 Bit4 ON 
 

 

● To run the programs stored in built-in flash memory by WriteEZ5, use following settings and re-supply power.  

SW1 

 Bit1 OFF 
 Bit2 OFF 
 Bit3 OFF 
 Bit4 ON 
 

 

● Please change to the following settings when you connect N-Wire emulator. 

SW1 

 Bit1 OFF 
 Bit2 OFF 
 Bit3 OFF 
 Bit4 ON 
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● Bit5-8 of SW1 is connected with the following terminals CPU.  

There are connecting to pull-up resister. When the switch is pushed down, it sends signal "Low". 

 

 SW1 

 Bit5 P76 
 Bit6 P77 
 Bit7 P78 
 Bit8 P79 
 

3.4.2. SW2 
 

This is the reset switch. You can reset the microcontroller by pressing this switch. 

 

3.4.3. SW3 (INTP17) 
 

SW3 is the push switch connected to ” P98/TENC01/INTP17/A8” pin in CPU. There are connecting to pull-up 

resister. When the switch is pushed down, it sends the signal of "Low".  

 

3.4.4. SW4 (INTP18) 
 

SW4 is the push switch connected to ” P912/TOAB1OFF/INTP18/A12” pin in CPU. There are connecting to 

pull-up resister. When the switch is pushed down, it sends the signal of "Low".  

 

3.4.5. LED11 (POWER) 
 

This is the POWER LED. It is lighted when it gets power supply. 

 

3.4.6. LED9, LED10 
 

The table shows the status of Ethernet transceiver. 

 Display Function 

LED9 LINK  Link ON Indication  

LED10 ACTIVITY Activity Indication 
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3.4.7. LED2,4,6,8 
 

LED can be lit with P94-P97.  

Please set the port mode to the output and output “Low” signal from the port. 

 

  Port 
LED2 P94 
LED4 P95 

LED6 P96 

LED8 P97 

 

3.4.8. JP1 
 

JP1 are the jumper switch pin of selection the power supply. 

 

JP1  

1-2 short It is supplied power from USB1 connector (for debug). 

2-3 short It is supplied power from AC adapter (+5V) connected to CN4. 

 

3.4.9. CN4 
CN4 is the power supply connecter of the AC adaptor. 

You can choose the power supplier by setting the JP1 to 2-3 short and connect 5V AC adapter. 

 

3.4.10. J1 
 

This is the connector for external power supply.  

 

3.4.11. NWIRE1 Connector 
 

These are connector for N-Wire emulator. 

It can connect N-Wire emulator of QB-V850MINI2 etc. 

The connector from KEL Corp. "8830E-026-170S" is mounted on NWIRE1. 

 

3.4.12. FP1 
 

This is the interface for connecting MINICUBE2. 

As a connector is not mounted, you need to solder 16pin connector ("FFC-16BMEP1" from Honda Tsushin Kogyo 

Co., Ltd.) on FP1. 
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3.4.13. USB1 
This is the USB interface for debugging. 

You can use this when you need to debug or make serial communication using P30 and P31. 

 

 

3.4.14. TR1 
This is the interface for Ethernet communication. 

TLA-6T718 from TDK Corp. is used for RJ-45 connector. 

LAN8700C from SMSC is used for Ethernet transceiver. 
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3.5 solder-short pad label 
 

When using a circumference board connector (CN1) without using a circuit on board, in order to separate a 

circuit on board, the terminal of CPU can be customized by making the pad for solder short opening. 

Pad for solder-short has shape like the figure below. 

 

When you make an open circuit, cut the narrow part of the Pad with a knife. 

To make short circuit, join the separated Pad with a soldering iron etc.  

 

Solder-short pad Solder-short pad    

（opened shape） Shorted shape 

 

 

 

 

State when 
shipping it 

Solder-short pad 

name 
Connection 

LED,2,4,6,8 
P94～P97 Short 

Open when using it for other usages 

VDD<-> Regulator output  
DCVDD1,2 Short 

Open, when you supply the power from CN1. 

P30/TXDC0  

RXD Short Open when P30 isn't used for USB1 communication 

interface. 

P912 <-->SW4 
P912 Short 

Open when using it for other usages 

4Pin U1 <--> T_RESET signal. 
T_RESET Short 

Open when the Reset IC isn’t used for. 

RFIC GPIO0 <==> P40 
GPIO0 Short 

Open when the port is using with CN1 

RFIC GPIO1<==> P41 
GPIO1 Short 

Open when the port is using with CN1 

RFIC GPIO2<==> P42 
GPIO2 Short 

Open when the port is using with CN1 
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Chapter4  Troubleshooting 
 

 
This chapter describes how to solve troubles you may face.  
 

4.1 If you cannot find USB driver when you connect PC to the kit 

 
Check Point 1 
If you use USB hub, do not use it. (USB hub is not supported) 
 
Check Point 2 
Check if you installed "NEC Electronics Starter Kit Virtual UART Driver" in "1.4USB Driver". If 
not, install the driver. 
 
Check Point 3 
If above 2 check points are confirmed, disconnect the USB cable from PC and re-connect 
again.  

 

4.2 Error when you start the debugger 

 
There could be several reasons to make errors happen. 
The solving processes differ depending on errors. Please check the error message first. 
The solving processes for each error are as follows. 
 

4.2.1. "Can not communicate with Emulator..." (F0100 or A0109) 
 

Check Point 1 
If you use USB hub, do not use it. (USB hub is not supported) 
 
Check Point 2 
Check if the settings of switches on the kit are correct with referring "2.5Check Board Settings". 
 
Check Point 3 
Confirm the USB driver installation with referring to "1.4USB Driver". 
 
Check Point 4 
If above 3 check points are confirmed, close the debugger and disconnect the USB cable from 
PC. Re-connect USB cable properly to both the PC and the kit, and then re-start the debugger.  
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4.2.2. "Incorrect ID Code." (Ff603) 
 
This error occurs when the security ID stored on microcontroller built-in flash memory is 
different from the ID code you entered at the start of debugger.  
 
Security ID entry area at the start of debugger 

 
 
Check Point 1 
Enter correct security ID and click OK on the configuration window. 
 
Check Point 2 
If you forgot the security ID, you have to erase the microcontroller built-in flash memory. Before 
erasing, check if you actually set the security ID. Also remember the code you set for the 
security ID. 
After this, erase the flash memory with referring to "5.4 WriteEZ5". 
 

 

4.2.3. Monitor memory cannot be accessed. (F0c72) 

 
Check Point 1 
Check if the settings of switches on the kit are correct with referring "2.5Check Board Settings". 
 
Check Point 2 
Erase the flash memory with referring to "5.4 WriteEZ5". 
 
Check Point 3 
If above 2 check points are confirmed, disconnect the USB cable from PC and re-connect 
again. 
And, retry starting the debugger. 
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Chapter5  Other Information 
 

 

This chapter explains some useful operation techniques of development tools and circuit diagram 
of the kit for developing of user programs. 
 

 

 

 

 
5.1 Create a new workspace (project)

 
 

 
 

5.2
 

 Register additional source file

 
5.3

 
 Debugger tips

 
5.4

 

 

 

 

 

 

 

 WriteEZ5 

5.5 Parts list, Circuit diagram

 55



Chapter 3 And More  

 

5.1 Create a new workspace 
 
 

Now, create a new workspace and project. 

PM+ allows you to create a new workspace with following "New WorkSpace" dialog.  

Select "File" on PM+ menu bar, then "New Workspace...". 

"New Workspace" dialog 

opens 

   

 
<Description of items> 

Workspace File Name: 
 -> Specify the name of the workspace file that 

manages the project files. 
.prw is automatically suffixed as the file type.
A project file (.prj) of the same name is 
simultaneously created. 

Folder: 
 -> Specify the folder for saving the workspace 

file by writing its absolute path. 
    This item can be selected from a reference 

dialog box by pressing the Browse… button.

 Project Group Name: 
 -> Specify this item if wishing to manage 
multiple projects together in function units. 
If nothing is specified, this item is the same 
as the workspace file name. 

Microcontroller Name:  

The concrete information set here is 

described on the following pages 

 -> Specify the name of the microcontroller to be 
used.  

 
D evice Name: 
 -> Specify the name of the device to be used. 
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Input the workspace information
setting as follows. 
 
Workspace file name 
 → test 

 C:¥TK850¥test 

 V850 Series 

 uPD70F3783 
 

Click  Next >  button 

 
 

 
Click  Yes  button 

 

 

Folder 

 →

Project Group Name 
 → (no input) 

Microcontroller Name 
 →

Device Name 
 →

 

 
Click  Detail Setting  button 
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Set the version of tools as 

follows. 

CA850：W3.30 

ID850QB：V3.60 

 
Select tools as above screenshot, then click  OK  . 

 

 

 

 
Click  Next >   
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Press the Next > button. 
 

 

Select the “Copy and Use the 

Sample file”. 

 

Select the “ 32-Register Mode”. 

NPress the ext > button. 
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Select the “Create and Use the 

sample file” 

 
Press the Next > button. 

 

 

 

 
Press the Next > button. 
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Press the Next > button. 

 

 

 

 
Press the Finish button. 

 

 

 

 

Check the project information 

setting contents. 

Select the “ID850QB V3.60” 
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This completes workspace and project creation. 

Additional source files can be registered at any time thereafter. 

For details, refer to “Registering additional source files”. 

 

 

Next, setup the security ID 

In the PM +, [Tool] → [Compiler common Options...] is selected. 

 

The “test” project has been 

registered. 
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The actualities of 

 "FFFFFFFFFFFFFFFFFFFF"(20 of F) 

are taken if there is no problem in the 

value of ID in security. 

 

Click the “Device” tab. 

 

 

 

Compiler Common Options 

setting is open. 

 
Press the OK button. 

 

Security ID settings are complete 
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5.2 Register additional source file 
 

 

Now, register additional source files. 

The following example shows the additional registration of source files “b.c” and “c.c” with source file “a.c” already 

registered. 

Place the cursor on the source file in the Project window of PM+, and select [Add Source Files…] displayed in the 

right-click menu. 

 

 

 

Select source files "b.c" and "c.c", 

then click  Open 

 
 

 

Multiple source files can be selected by clicking them with pressing  Ctrl  key. 
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Source file "b.c" and "c.c" 
are additionally registered 

to the project. 
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5.3 Debugger tips 
 

 

This section describes some useful techniques for the debugger (ID850QB). 

 

5.3.1. Change display of buttons 
 

Execution controls (run, stop, step-in debugging, reset, etc) and opening functional window can be made by 

below buttons. However, it could be difficult to know which button does what.  

 

 
 

In this case, select "Options" on menu bar, then "Debugger Options". Check "Pictures and Text" on setting area. 

 

 
 

With this setting, the buttons display the text as well, so that it is easier to know what they are. 

 

 

 

5.3.2. Display source list and function list 
 

When you wish to see source file list or function list, select "Browse" on menu bar, then "Other" -> "List" to open 

the list window. The information in the windows is synchronized. Therefore, it is not just for referring to the list, but 

it is useful when you wish to update files or functions.  

 

 

 

When you click "main"... Source window shows "main" 
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5.3.3. Set/delete breakpoints 
 

Breakpoints are executed by clicking lines in which " * " is displayed 

"B" is displayed in the line where a breakpoint is set. 

Breakpoints are deleted by clicking "B". 

 

 

 

 

 Click 
 

 

 

 

 

 

 

 

 

 

 

 

Breakpoint was set 
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5.3.4. Display global variables 
  

With using Watch Window, you can display global variables. There are several ways to register global variables to 

watch window. In this section, how to register from source window is described. 

 

Right-click the variable on source window, then select "Add Watch..."  

 

 
 

Add Watch dialog opens. Click  OK  . 

 

 
 

Adding a variable to watch window is completed. 
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5.3.5. Display global variables (internal RAM) while programs are running 
 

RAM, general-purpose register, and SFR can be referred by the pseudo real-time monitor function even when the 

programs are running. 

 

Select "Option" menu -> "Extended Option...". Follow below settings.  

 

Check

 

 

 

 

 

 

 

Specify the sampling time (ms) of the real-time monitor function (default: 

500ms). The sampling time can be specified in 100-ms units from 100 to 

65500. 
It will not monitor if it is set to "0" or blank. 

 

 

 

 

Note: 
・ The user program momentarily breaks upon a read. 
・ Do not use the pseudo real-time monitor function while using the memory window. It uses the system 

resources significantly as it monitors the displaying memory as well. 
・ It is recommended to close the memory window when you use the pseudo real-time monitor function. 
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5.3.6. Display local variables 
 

Local variable window is used to display local variables. 

By clicking the button below, you can open the local variable window. 

Unlike global variables, local variables cannot be displayed when programs are running. 

 

 

 

 

 

 

 

 

5.3.7. Display memory and SFR contents 
 

By clicking the button below, you can open the memory window. 

 

 

 

 

 

 

 

 

 

 

 

By clicking the button below, you can open the IOR window. 
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5.4 WriteEZ5 
 

 

 
Since the program downloaded by ID850QB includes monitoring files for debugging, it cannot run 
stand-alone. However, if you use WriteEZ5 to write programs, it does not write monitoring files. 
Therefore, it can run stand-alone. 
Also, if you forgot the security ID or if you set On-Chip Debug Option Byte to disable the on-chip 
debug function, you cannot start debugger. In this case, you need to delete the setting values of 
security ID and On-Chip Debug Option Byte. Use WriteEZ5 to erase the flash memory. 
 
WriteEZ5 is installed at "1.2Installation of Software Development Tools". 
Start WriteEZ5 by selecting "Windows Start" menu, "Programs", "NEC Electronics Tools", 
"WriteEZ5", "V1.00", and "WriteEZ5". 
 
The hardware for WriteEZ5 is incorporated in TK-850/JH3E+UD. 
 
 
① The switch of TK-850/JH3E+UD is set as follows, and connects TK-850/JH3E+UD to PC.  

   

SW1 

 Bit1 OFF 
 Bit2 ON 
 Bit3 ON 
 Bit4 ON 
 

 

 

② Please execute WriteEZ5.  
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③ Push the「Setup」button. 

 
 

 
 
④ Push the「PRM File Read」button. 
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⑤ Please select “70F3783_CSI0.prm” in the directory of “¥PRM¥PRM70F3786_V100” in the 
CD-ROM. 
 

 
⑥ "Port" selects the COM port number where TK-850/JH3E+UD is allocated. 

 
Only the COM port number that the personal computer has is displayed in this pull- 
down menu. 
Input “6.00” to “Frequency” 
Input “8.00” to “Multiply rate” 
Input “38400” to “Speed”, and chick “OK” 
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⑦ "Erase" The deletion of the flash memory begins when the button is pushed. 

 
 

 
⑧ When you write the program, click “load” then select writing HEX file. 
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⑨ Hex file writing will be start by clicking “AutoProcedure” . 
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5.5 Parts list, Circuit diagram 
 

 

 

From following page, it shows the parts list and the circuit diagram of the kit. 

 

●CPU board parts list 
No. Mount 

Quantity  
Mount Parts Reference Unmount Parts Reference Type Parts No Maker Note 

1 0    CN1 Connecter FX8C-100P-SV6(92) HIROSE   
2 2  CN3,CN2   Connecter TFM-110-02-S-D-A-K-TR SAMTEC   
3 1  CN4   Connecter HEC0470-01-630     
4 23  C1,C2,C3,C4,C5,C6,C10,   

Chip ceramic cap 
0.1uF   C46～C49 

Option 
    C14,C16,C17,C18,C19,C23,           
    C24,C25,C27,C28,C29,C30,           
    C31,C32,C43 C46,C47,C48,         
    C50 C49         
5 2  C7,C8   Chip ceramic cap 18PF     
6 3  C9,C11,C33   Chip ceramic cap 4.7uF(2125)     
7 6  C12,C13,C34,C35,C36,C37   Chip ceramic cap 10pF     
8 2  C21,C15   Aluminum Electrolytic 

Cap 
4.7uF/25V     

9 2  C20,C22   Chip ceramic cap 0.47uF     
10 2  C40,C26   Chip ceramic cap 0.1uF(1608)     
11 1  C38   Chip ceramic cap 0.022uF/50V     
12 0    C39,R55,R62,R63,R64,R65, Chip ceramic cap xxx     
      R66         
13 2  C42,C41   Chip ceramic cap 7PF     
14 2  C45,C44   Aluminum Electrolytic 

Cap 
10uF/25V     

15 0    DCVDD1,DCVDD2 Pad SSP     
16 0    FP1 Connecter FFC-16BMEP1 HONDA   
17 0    GPIO1,GPIO2,P76,P77,P78, Pad SS     
      P79,P94,P95,P96,P97,P98,         
      P912,T_RESET,RXD,GPIO0         
18 1  JP1   Connecter FFC-3AMEP1 HONDA   
19 0    J1 Connecter FFC-2AMEP1 HONDA   
20 0    LED1,LED3,LED5,LED7 LED SLR-332MC ROHM   
21 4  LED2,LED4,LED6,LED8   LED SML-311UT ROHM   
22 3  LED9,LED10,LED11   LED PG1112H ROHM   
23 0    LED12 LED SLR-332VC ROHM   
24 1  L1   Filter BLM41PG750S Murata   
25 3  L2,L3,L4   Filter BLM18PG600SN1 Murata   
26 2  MR2,MR1   resister module CN1E4K-105J KOA   
27 1  NWIRE1   Connecter 8830E-026-170S KEL   
28 18  R1,R2,R3,R4,R5,R6,R7,R8,   Chip resister 10K     
    R12,R13,R16,R17,R18,R22,           
    R30,R31,R36,R44           
29 11  R9,R19,R20,R21,R23,R26,   Chip resister 1.5K     
    R27,R28,R33,R37,R43           
30 12  R10,R14,R45,R46,R47,R48,   Chip resister 100     
    R49,R50,R51,R52,R53,R54           
31 5  R11,R24,R25,R29,R32   Chip resister 100K     
32 5  R15,R59,R61,R67,R68   Chip resister 0     
33 2  R34,R35   Chip resister 27     
34 4  R38,R39,R40,R41   Chip resister 49.9(1%)     
35 1  R42   Chip resister 10(1%, 0.1W)     
36 1  R56   Chip resister 1M     
37 1  R57   Chip resister 12.4K(1%, 0.1W)     
38 3  R58,R60,R69   Chip resister 270     
39 1  SW1   DIP SW CHS-08B COPAL   
40 3  SW2,SW3,SW4   DIP SW SKQMBB ALPS   
41 0    TPU1,TPU2,TPU3,TP3,TPU4, Pad TPD05     
      TP4,TPU5,TP5,TPU6,TPU7,         
      TPU8,TPU9         
42 0    TP1,TP2 Check Pin LC-2 MAC8   
43 1  TR1   Connecter TLA-6T718 TDK   
44 1  USB1   Connecter UX60SC-MB-5ST HIROSE   
45 1  U1   IC S-80129ANMC-JCOxG SII   
46 1  U2   IC uPD70F3783GF-GAT-AX NECEL   
47 1  U3   IC SN74LVC2G125DCU TI   
48 1  U4   IC SN74LVC3G07DCT TI   
49 1  U5   IC UPD78F0730MC NECEL   
50 1  U6   IC SN74LVC1G125DCK TI   
51 1  U7   IC LAN8700(i) SMSC   
52 1  U8   IC LM1117MPX-3.3 NS   
53 0    U9 IC IS61WV51216BLL-10TLI ISSI Option 
54 0    U11,U10 IC SN74LVC573APW TI Option 
55 0    U12 IC SN74LVC08APW TI Option 
56 1  Y1   

Resonator 
CX1255GB06000H0PESZ
Z Kyocera 

  

57 1  Y2   Resonator MC-306 32.7680K-A0 EPSON   
58 1  Y3   Resonator CSTCE16M0VH3L99-R0 Murata   
59 1  Y4   

Resonator 
NX3225GA-25.000M-STD
-CRG-2 

NDK   
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●RF board parts list 
No. Mount Quantity  Mount Parts 

Reference 

Unmount Parts 

Reference 

Type Parts No Manufacturer 

1 2 C37,C43   Chip ceramic cap C0402CRNP09BNR50 Yageo 

2 1 C38   Chip ceramic cap CC0402CRNPO9BN1R8 Yageo 

3 2 C1,C53   Chip ceramic cap C0402ZRY5V5BB105 Yageo 

4 LQG15HN5N1S02 Murata 

4R 

1 L3,L5   Chip ceramic inductor

AL02BT5N1M Viking 

5 1 L4   Chip ceramic inductor LQG15HN6N8J02 Murata  

6 1 R5   Chip resister RC0402JR-0710M Yageo 

7 4 C5,C39,C52,C63   Chip ceramic cap C0402ZRY5V7BB103 Yageo 

8 2 C2,C4   Chip ceramic cap C0805ZKY5V6BB106 Yageo 

9 1 C3   Chip ceramic cap C0603ZRY5V6BB475 Yageo 

10 2 C21,C54   Chip resister C0402JRNP09BN150 Yageo 

11 1 XTAL_2   Resonator G5 Series 32.768kHz Ecera 

12 1 XTAL_1   Resonator 7M32000044 TXC 

13 2 C60,C64   Chip resister C0402JRNP09BN330 Yageo 

14 1 C48   Chip ceramic cap C0402JRNP09BN390 Yageo 

15 5 C19,C40,C44,C55,C57   Chip ceramic cap CC0402JRNPO9BN470 Yageo 

16 1 C45   Chip resister C0402ZRY5V7BB104 Yageo 

17 0   R1 Chip resister RC0402JR-070R Yageo 

18 1 L2   inductor LQH2MCN8R2M02 Murata 

19 1 CON2   Connecter   HO YANG SYONE 

20 2 CN3,CN4   Connecter SFM-110-02-S-D-A MetaTech 

21 1 S1   Connecter 7865NS502BD000B BO-JIANG 

22 1 U1   UZ2400.D   UBEC 
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●CPU board circuit diagram  
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● RF board circuit diagram 
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Chapter6  Sample Program 

 

 

 

This chapter introduces the usage of other sample programs. 
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6.1 RF Test Program 

 

 

 

This chapter describes how to run the RF test program using TK-850/JH3E+UD and 
TK-78K0R/KG3+UD. 
The RF test program can monitor the “Packet Error Rate”, “Received Signal Strength Indication”, 
etc. 
The RF test program uses USB interface on TK board for the serial port. If you try to write 
programs with using ID850QB debugger, the monitor program will be written as well. This causes 
programs not to work appropriately. Therefore, you need to use the flash memory program 
software (WriteEZ5) to write programs. 
 
 
6.1.1. Procedure for one to one transmit/receive test 
 
For the RF test, prepare one TK-78K0R/KG3+UD board and write the program 
"TK78K0RUD_RFTEST.hex", which is bundled with TK-78K0R/KG3+UD. 
 
In the same way, prepare one TK-850/JH3E+UD board, write the program 
"C:¥TK850¥JH3E+UD¥V850ES_RF_Test¥Release¥RF_TEST.hex", by using WriteEZ5. 
For writing programs to flash memory, refer to "5.4WriteEZ5". 
  
* The RF Test Program uses USB interface on TK board for the serial port. If you try to write 

programs with using ID850QB debugger, the monitor program will be written as well. This causes 
programs not to work appropriately. Therefore, you need to use the flash memory program 
software to write programs. In the same way, you cannot debug the programs using ID850QB. 

(Hereinafter, TK-850/JH3E+UD board and TK-78K0R/KG3+UD board are reffered as to the 
transmitter and the receiver, respectively). 
 

Transmitter TK-850/JH3E+UD Receiver TK-78K0R/KG3+UD  

Write "V850_RF_Test" Write "TK78K0RUD RFTEST"  

 

 

 

 

 

 

 

 

 Short address：0001 Short address：0002 
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 Please set the switches on the receiver board (TK-78K0R/KG3+UD) as follows. 

 

JP1 1-2 Short (USB side) 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 OFF 
Bit5 OFF 

SW1 

ON for address settingBit6 
Bit7 OFF for address setting 

ON for the Receive modeBit8 
 

The above example is for the short address of 0002. 

There are four ways of the address setting as follows, 

 

Short Address 
 

0001 0002 0003 0004 

Bit6 OFF ON OFF ON 
SW1 

Bit7 OFF OFF ON ON 

 
By setting SW1-8 to ON, it becomes the receive mode. If you set them to OFF, it becomes 
HyperTerminal key input mode (this mode will be explained later in this document)  
Please connect the receiver board (TK-78K0R/KG3+UD) to your first PC with a USB cable. 

 

Now the receiver board(TK-78K0R/KG3+UD) is ready. 

 

Next, you will set the transmitter (TK-850/JH3E+UD) and PC. 
 Please set the transmitter (TK-850/JH3E+UD) board as follows, 

 

JP1 1-2 short(USB side) 
Bit1 OFF 
Bit2 OFF 
Bit3 OFF 
Bit4 ON 
Bit5 OFF 

SW1 

Bit6 OFF 

Bit7 OFF 

Bit8 OFF 
 

This board is designated as the transmitter. 
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Then, please connect it to your PC with a USB cable. 

 

Then, please identify the COM port number of the USB in your PC  

at [Control Panel]  [System]  [Hardware]  [Device Manager]  [Ports (COM&LPT)]  

 

Hyper Terminal 
 

On MS-Windows in your PC, please select [All Programs] -> [Accessory] -> [Communication] -> 

[HyperTerminal] 

 

Setting of HyperTerminal 

  

 Bits per second 115200 
 Data bits 8 
 Parity 
 

None 

Stop bits 1 
 Flow control None 
 

 (Property -> Setting -> ASCII) 

 Local Echo OFF 

 No Line Feed 
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Reset the transmitter board. 
 
Press RESET (SW2) on transmitter board (TK-850/JH3E+UD). 
 
 
Now you will find the following opening menu in the window. 

 

 

---------------------------------------------- 
1. PER test / sender (shift+1 .. Retry result) 
2. PER test / receiver 
3. Continuous TX / Pseudo Noise 
4. Continuous TX / Raw carrier 
---------------------------------------------- 
5. RX mode 
6. Idle mode 
8. Standby mode 
9. Deep Sleep mode 
0. Power down mode 
---------------------------------------------- 
A. Set RF channel 
C. Disable CSMA/CA 
M. Manually set RF registers 
P. Packet receive report: RSSI/LQI 
T. Packet Transmission for the command P 
R. Reset RF 
---------------------------------------------- 
My MAC_ADDR = 0x0001 
Command? > 
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Execution of the Transmit/Receive Test 
 

To initiate the PER, Packet Error Rate, test, please press “1” in the menu. You will see [My Profile], 

then, be asked for the destination of the PER test, as shown below. 

 

 

Command? >1 (PER test/sender) 
 
[My Profile] 
------------------------------------- 
  MAC : 22:95:00:01:00:00:00:47 
Short : 0001 
PanID : 2514 
------------------------------------- 
Send to (Short addr) ? : 

 

Now, you may input “0002”. 

Then, you will be asked how many packets you wish to consume in the PER test. 

You may input “1000”. 

Then, you will be asked the interval of packets in msec. 

You may input 3 msec. 

Then, the PER test will be executed.  
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You will see, 

the number of packets sent, that is, 1000 as you input, 

the number of the received packets, 

the calculated PER in % 

and the maximum and minimum RSSI values in the PER test. 

 

[Note]  

PER= Packet Error Rate 

RSSI= Received Signal Strength Indication 

 

 
 

Send to (Short addr) ? : 1 (PER test/sender) 
 
[My Profile] 
------------------------------------- 
  MAC : 22:95:00:01:00:00:00:47 
Short : 0001 
PanID : 2514 
------------------------------------- 
Send to (Short addr) ? : 2 
Send count (dec)     ? : 1000 
Interval (dec/msec)  ? : 3 
[Set channel to 11 (Cmd)] 
Prepare to send..OK 
[Set channel to 11 (Current)] 
Request to result..OK 
 
 
[Results] 
------------------------------------- 
From     : 0001 
To       : 0002 
------------------------------------- 
Sent     : 1000 
Received : 1000 
PER      :   0.0000% 
RSSI     : max ff / min 9d 
------------------------------------- 
 
Press any key to the menu 

RSSI is expressed in the hexagonal value of 256 levels, which indicates the signal strength in the 

received signal. For more details of the RSSI value, please refer to the datasheet of the UZ2400 

RF chip. 

 

Please note the PER and the RSSI are measured at the receiver side. 

The receiver does not send back the test packets, but only the test result. 
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6.1.2. PER test / receiver 

 

The Menu 2 sets the board to the receiver in the PER test. 

If you have two PCs, you can connect two boards to each of two PCs, then, you will apply this 

mode to one of them.  

In your current case, your receiver board is now being connected to the debugger. Therefore, you 

cannot access to these menu to utilize this mode setting. Alternatively, you have set the receiver 

board to the receiver mode by setting the switch 1-8. 

 

6.1.3. Continuous TX / Pseudo Noise 

 

The Menu 3 initiates the modulated RF transmission. The data carried are pseudo random 

numbers. You can define the channel using the menu A, and the output power using the menu 0. 

 

 

6.1.4.  Continuous TX / Raw carrier 

 

The Menu 4 initiates the carrier transmission. The output power is not 0 dB as a reset default. You 

can define the channel using the menu A. 

 

6.1.5. RX Mode 

 

The Menu 5 initiates the receiver mode. 

 

6.1.6. IDLE MODE 

 

The Menu 6 sets the UZ2400 into the IDLE mode. 

 

6.1.7. Sleep MODE 

 

The Menu 7 sets the UZ2400 into the Deep Sleep mode. 

 

 

6.1.8. Standby MODE 

 

The Menu 8 sets the UZ2400 into the Standby mode. 
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6.1.9. Set RF channel 

 

The Menu A allows you to set the RF channel. 

 

 

 

6.1.10. Manually set UZ2400 register 

 

The Menu M allows you to set the UZ2400 registers. 

Please refer to the datasheet of the UZ2400 RF chip for the definition of registers. 

 

 

6.1.11. Resetting RF 

 

The Menu R allows you to reset the UZ2400 registers. 
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6.1.12. Channel setting 
 

In the previous example, you may have also found the RF channel used in this test is the Channel 11. The channel 

is specified by the IEEE 802.15.4 specification. 

The channel 11 is assigned at 2405 MHz. You can change the channel in the PER test in 5MHz step to the 

maximum channel of 26th at 2480 MHz. 

To do it, please press “A” in the command prompt. Then, please choose the channel by [+], [-], [A], [B], or [C]. In the 

example below, the channel 23th, 2465 MHz, was selected.  
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To execute the PER test at the channel 23, press [Enter] in your keyboard, then, 

choose “1” to initiate the PER test mode. Then, you may input 1000 packet in 5 msec interval to see the following 

example. Please confirm the channel used is 23th in the display. Please note the receiver will learn which channel is 

to be used for the test automatically. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

[My Profile] 
------------------------------------- 
  MAC : 22:95:78:01:00:00:00:47 
Short : 0001 
PanID : 2514 
------------------------------------- 
Send to (Short addr) ? : 02 
Send count (dec)     ? : 1000 
Interval (dec/msec)  ? : 5 
[Set channel to 11 (Cmd)] 
Prepare to send..OK 
[Set channel to 23 (Current)] 
Send..     0 
Request to result..OK 
 
 
[Results] 
------------------------------------- 
From     : 0001 
To       : 0002 
------------------------------------- 
Sent     : 1000 
Recieved : 1000 
PER      :   0.0000% 
RSSI     : max FF / min FF 
------------------------------------- 
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6.1.13. Adjusting the output power 
 

You may wish to control the output power in the PER test.  

For it, please select “M” in the menu. 

You will be asked the register ID. Please input “274”. 

Then you will see, “LREG[274] : 00 >”. 

It means the current value at the register [274] is 0xC4h, which means 0 dB. 

0xC4h is the reset default. 

 

 

The register bits are defined as follows, 

 

LREG[274]: [7:6] -> large scale tuning 

C4: 0 dB  

81: -8 dB 

09: -16 dB 

01: -24 dB 

 

LREG[203]: [7:3] -> small scale tuning 

000000: 0 dB 

000001: -0.1dB 

| 

111111: -8.00 dB 

 

For instance, if you wish -8 dB, please input “81”, as follows, 

 

“LREG[274] : C4 > 81”  

 

Then, you will start the PER test. 
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6.2 Ethernet gateway sample program 
 

 

 

This Ethernet gateway sample program starts working automatically as Zigbee coordinator when it is 

turned on, and you can collect network information of the Zigbee network via Ethernet. 

For use, write [TK-850JH3E+UD_ZC.hex] to the TK-850/JH3E+UD with the WriteEZ5. 

Refer to the "TK-850/JH3E+UD sample program reference manual" for details. 
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Chapter7  Mode setting of the TK-850/JH3E+UD board 

 
 

The combination table of the switch of this board is shown. 
 
 
 SW1  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

＊ Set this ON when you use serial communication through USB connection. 
 

Case
Switch 

Debug, WriteEZ5 Normal mode N-Wire emulator  Mode with USB 
SW1 - 1 OFF OFF OFF 
SW1 - 2 OFF ON OFF 
SW1 - 3 OFF ON OFF 

OFF/ON ＊ OFF/ON ＊ SW1 - 4 ON 
SW1 - 5 Don’t care Don’t care Don’t care 
SW1 - 6 Don’t care Don’t care Don’t care 
SW1 - 7 Don’t care Don’t care Don’t care 
SW1 - 8 Don’t care Don’t care Don’t care 
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Mode setting of the TK-78K0R/KG3+UD board 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 JP1

 
 
 SW1 

 
 
 
 
 

Usage case 
SW 

Normal   
(Written program works)

Debug   
(USB Connection) 

JP1 
Select by power supply

source 
1-2short (USB side) 

Bit1 OFF ON 
Bit2 OFF ON 

Bit3 OFF ON 

Bit4 ON OFF 

SW1 

ON Bit5 OFF 
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